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 UVOD 

 

U ovom diplomskom radu predloženi su istražni radovi i granice rezervi arhitektonsko-

građevnog kamena u ležištu „Razvala“, kod Bosanskog Grahova, koje pripada istražnom 

prostoru „Smiraj“. Detaljno je opisan način izrade 3D modela područja istražnog prostora 

na jednom jednostavnom i stvarnom primjeru. Tema ovog rada je, uz prikaz općih podataka 

o ležištu arhitektonsko-građevnog kamena ̋ Razvala˝, postupak izrade 3D modela postojećeg 

stanja i 3D modela budućeg ležišta. 

 Bilo je potrebno prikupiti postojeće geološke i topografske karte užeg i šireg područja 

u odgovarajućem mjerilu. Temeljem topografskih karata izrađena je situacijska karta užeg i 

šireg područja. Ta karta poslužila je za 3D modeliranje, odnosno proračun rezervi 

arhitektonsko-građevnog kamena.  

 Na postojeću situaciju pružanja stijena, dan je prijedlog metode dobivanja blokova i 

opisana je potrebna mehanizacija.  

 Vektorizacija topografskih karata, triangulacija situacijske karte, 3D modeliranje, te 

proračun rezervi obavljen je u suvremenom računalnom programu Bentley Microstation, te 

aplikacijama mod-z i InRoads kojima se upravlja pomoću Microstation-a.  

Opisani postupak rezultira prikazima ležišta „Razvala“ i okolnog terena te olakšava 

izradu projektne dokumentacije.  
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 OSNOVNE ZNAČAJKE PODRUČJA ISTRAŽIVANJA 

2.1. Geografski položaj ležišta „Razvala“ 

 

Istražni prostor arhitektonsko građevnog kamena (u daljnjem tekstu a-gk) „Smiraj“ 

nalazi se u Hercegbosanskoj županiji u općini Bosansko Grahovo. Ležište “Razvala” nalazi 

se na južnom dijelu općine Bosansko Grahovo, neposredno uz  magistralni put Bosansko 

Grahovo – Livno, 3 km od mjesta Luka, kao što je prikazano na slici 2-1. Istražno područje 

se nalazi u pustom nenaseljenom prostoru omeđen šumom, niskim raslinjem ogoljenim 

padinama koje su u općinskom vlasništvu. 

Geografski  položaj šireg područja ležišta „Razvala“ prikazan je u programu Google 

Earth, pomoću naredbe u programu Microstation: File/Export/Google Earth. 

 

 

 
Slika 2-1 Geografski  položaj ležišta „Razvala“ u M 1 : 200 000 

 

Uže područje istraživanja ograničeno je u obliku četverokuta čiji su vrhovi označeni 

točkama 1, 2, 3 i 4. Koordinate vršnih točaka istražnog prostora prikazane su tablicom 2-1. 

U morfološkom pogledu, teren je brdovit-planinski, s kotama između 800 i 1300 m. 
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Slika 2-2 Topografska karta s prikazom položaja ležišta „Razvala“, TK25 umanjena na M 1 : 50 000 

 

Trgovačko društvo DINARAKAMEN d.o.o. iskazalo je interes za istraživanje i 

eksploataciju arhitektonsko-građevnog kamena na području istražnog prostora „Razvala“, 

dok je u svrhu ovoga rada razmatrano uže istražno polje „Razvala“, kao što je prikazano na 

slici 2-2. Tijekom 2012. godine provedena su probna istraživanja i izrađen je program 

istraživanja. U cilju izrade diplomskog rada dio istražnog prostora, koji obuhvaća površinu 

od 427,75 hektara, uzet je kao predložak za istraživanje ležišta a-gk. 

 

Tablica 2-1 .Koordinate vršnih točaka ograničenog ležišta arhitektonsko-građevnog kamena “RAZVALA” 

Vršna točka 
Koordinate  Nadmorska 

visina (m) Y X 

1 6370187 4890036 920 

2 6372314 4890036 820 

3 6372314 4888026 950 

4 6370187 4888026 1310 

Površina istražnog prostora: 427,75 ha 

  

Visinska razlika na nekim dijelovima prostora seže i do 400 m, gdje je točka 2 na 

820 m a 4 na 1310 m (razlika od 390 m). 

Prometna povezanost do ležišta „Razvala“ je dobro riješena izgradnjom  

makadamskih cesta za potrebe šumarije, koje će se bez velikih poteškoća daljnjim uređenjem 

moći koristiti za transport sirovine.
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 GEOLOŠKE ZNAČAJKE TERENA 

3.1.  Geološka građa šireg područja ležišta a-gk „Razvala“ 

 

Temeljem osnovne geološke karte (Slika 3-1) OGK, list Knin (Grimani i dr., 1996), 

utvrđeno je da je šire područje istražnog prostora "SMIRAJ" izgrađeno od više različitih 

facijalnih razvoja.  

 

 

Slika 3-1 Prikaz OGK, list Knin sa ucrtanim granicama ležišta ˝Razvala˝, M 1 : 100 000 (Grimani i dr., 

1996) 

 

 

Slika 3-2 Tumač OGK, list Knin (Grimani i dr., 1996) 
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Temeljem osnovne geološke karte (OGK), list Knin (L33-141) i prospekcijom terena 

utvrđeno je da na nekoliko lokaliteta na području planine Dinare, oko 1 km zapadno od sela 

Ugarci i jugozapadno od sela Luka sve do Likuše, preko Malog i Velikog Poda, preko 

Razvale sve do Crnog Vrha i dalje do Brezovca, postoje značajne naslage uslojenog 

vapnenca. Rekognosciranjem terena i upoznavanjem geologije šireg i užeg područja izabran 

je istražni prostor ''SMIRAJ''. U geološkom pogledu jurski vapnenci Lijas J1,  Doger J2  i Malm 

J3
1,2, vidljivi sa slike 3-1 i navedeni u legendi kartiranih jedinica sa slike 3-2, pripadaju u 

istražnom prostora grupi čvrstih stijena sedimentnog porijekla s malim stupnjem ispucanosti 

stijenske mase u površinskoj zoni (Dragičević i dr., 2012).  

 

Lijas J1 - Južno od Bosanskog Grahova u području Likuše, (Istražni prostor ̋ Smiraj˝),  zatim 

u širem području Polače, u nižim dijelovima strmih jugozapadnih padina Dinare, na 

padinama Vršine i u Suhom polju na osnovu paleontoloških podataka i litoloških značajki 

izdvojene su naslage donjeg, srednjeg i gornjeg lijasa. U donjem dijelu lijaskih naslaga 

prevladavaju tamnosivi i sivi vapnenci, a izmjenjuju se s tamnosivim i smeđim krupnozrnim 

dolomitima. Petrografske analize su pokazale, da vapnenci donjeg lijasa pripadaju tipu 

kalcilutita i kalkarenita, dok su dolomiti nastali potpunom ili djelomičnom dolomitizacijom 

kalcilutita. Sedimentacija iz donjeg lijasa u srednji lijas je kontinuirana. Debljina 

donjolijaskih naslaga iznosi oko 200 m. Naslage srednjeg lijasa se sastoje od smeđih, sivih i 

tamnosivih, ponekad bituminoznih vapnenaca. Vapnenci su odlično uslojeni i često pločasti. 

Vertikalna izmjena raznih tipova vapnenaca u srednjem lijasu ukazuje, da je u 

sedimentacijskom bazenu dolazilo do čestih promjena hidrodinamskih uvjeta. 

U srednjem lijasu redovito dolaze jedna ili dvije, nekoliko metara debele zone 

vapnenca ili dolomitičnih vapnenaca s brojnim presjecima litiotisa. Sedimentacija iz 

srednjeg lijasa u gornji lijas je postupna. Debljina naslaga iznosi oko 180 metara. U gornjem 

dijelu naslaga lijasa zastupljeni su svjetlije ili tamnije smeđi pločasti vapnenci. U 

vapnencima su česti proslojci glinovitih vapnenaca, dok se rjeđe nalaze nakupine i ulošci 

žućkastih glina. Za ove  naslage, zbog sadržaja glinovite supstance, često se upotrebljava 

naziv ''mrljasti'' vapnenci. Debljina gornjeg lijasa iznosi oko 130 metara. 

 

Doger J2 - Dogerske naslage su uglavnom zastupljene jednoličnim razvojem tamnije ili 

svjetlije sivih i smeđih odlično uslojenih vapnenaca. U izmjeni s debljim zonama vapnenca 

nalaze se tanje zone, proslojci ili ulošci sivih i smeđih zrnatih dolomita ili rijetki proslojci 
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oolitičnih vapnenaca. Prosječna debljina slojeva se kreće od 20 do 60 cm, a pojedini slojevi 

dosežu debljinu i preko metar. Partije deblje uslojenih vapnenaca u izmjeni s proslojcima 

dolomita tvore zone, koje se markantno ističu na terenu. Prikaz s površine Dogerskih naslaga 

možemo vidjeti na slici 3-3 (snimljeno na jednom od prvih istražnih zasjeka). 

 

 
Slika 3-3 Prikaz terena 

 

Malm J3
1,2 - U širem području sjeverozapadnog dijela Dinare (ležište  ''Razvala“), naslage 

starijeg malma rasprostranjene su na velikom prostranstvu. Sastoje se pretežnim dijelom od 

smeđih i sivosmeđih debelouslojenih krupnozrnih dolomita. Dolomiti su podatni trošenju u 

područjima njihova rasprostranjenja nalazimo najizrazitije oblike krškog reljefa. 

 

3.2. Tektonika 

 

U tektonsko-strukturnom pogledu područje istražnog prostora ''SMIRAJ'' nalazi se 

sjeveroistočnom dijelu strukturne jedinice Podinarje i sjevernom dijelu strukturne jedinice 

Dinara. 

Tektonska jedinica Podinarje formirana je između jedinica Ilica, Krčić i Dinare. 

Relativno je uska i prati jedinicu Dinare. Obuhvaća naslage od gornjeg trijasa do donje krede, 

sa brojnim različito orijentiranim rasjedima. Generalno naslage padaju prema jugoistoku i 

istoku. 

Tektonska jedinica Dinara formirana je, kao rasjedima poremećena sinklinala, u 

sjevernom dijelu, sa postupnim prijelazom u antiklinalu u južnom dijelu. Razvijene su 

naslage od lijasa do gornje krede. Odvojena je dislokacijskom zonom Bosansko Grahovo-

Borova Glava od strukturne jedinice Vijenac, a od jedinice Podinarje dislokacijskom zonom 
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Bosansko Grahovo- Brezovac-Glavaš. Duž ove dislokacijske zone naslage su izdignute, a 

naliježu na naslage jedinice Podinarje. 

Iz izloženoga rasporeda tektonskih jedinica vidljivo je, da su osim vertikalnih 

kretanja na konačno formiranje sklopa bitno utjecali i tangencijalni pokreti, koji bi 

dokumentirali starost glavne tektogene faze, može se smatrati, da su to bili pokreti koji su 

djelovali i  u širem području (Dragičević i dr., 2012).  

 

3.3. Mineralne sirovine u području istražnog prostora „Razvala“  

 

Unutar zatraženog istražnog prostora "Smiraj" neupitno se nalaze dolomiti i vapnenci, 

koji se izuzetno kvalitetni i upotrebljivi kao arhitektonsko-građevni kamen. Što više,  na 

ovom se prostoru nalazi nekoliko različitih vrsta kamena, kako po izgledu,  bankovitosti i 

uslojenosti, tako i po bojama od sivih, tamnosivih, smeđih do crnih (Dragičević i dr., 2012). 

 

3.4. Dosadašnja istraživanja arhitektonsko-građevnog kamena u užem području 

ležišta “Razvala” 

 

Prema programu istraživanja arhitektonsko-građevnog kamena u istražnom prostoru 

“Smiraj” Bosansko Grahovo (Dragičević i dr., 2012),  započeti su prvi istražni radovi s 

istražnim usjecima i zasijecima te probnom eksploatacijom, koje možemo vidjeti na  

slikama 3-4 i 3-5. 

 

Slika 3-4 Pregled istražnog zasjeka 



 

8 

 

 

Temljem dobivenih podataka s terena, dan je proračun za uže područje zahvaćeno 

istražnim usjecima i zasjecima. Proračunom eksploatacijskih rezervi: metodom srednje 

aritmetičke sredine (MSAV) dobivene su projekcije prvih očekivanih rezervi. Procjena 

rezervi prikazana je u tablici 3-1.  

 

Tablica 3-1 Procjena rezervi a-g kamena – Razvala (Dragičević i dr., 2012) 

 
 

 

 

 
Slika 3-5 Panorama zasjeka 

 

Također je provedeno uzorkovanje i istraživanje, određivanje kvalitete 

arhitektonsko-građevnog kamena u istražnom prostoru Smiraj, ležište Razvala kod Grahova 

(BiH), te su rezultati predočeni u Prilogu 2. 

 

 
Slika 3-6 Prikaz kamena dobivenog istražnim radovima 
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Zaključak je potvrdio i prvotna očekivanja, tj. da je područje ležišta Razvala bogato 

kvalitetnim arhitektonsko-građevnim kamenom, koji je kompaktan, vizualno atraktivan 

(vidljivo na slici 3-6), visoke tlačne čvrstoće i s vrlo malim upijanjem vode. Analizirana 

stijena ima visoku gustoću (oko 2,8 t/m3) i vrlo je tvrda prema otpornosti na habanje (9 po 

Bohme-u). Zaključno na temelju dobivenih rezultata kamen se može koristiti za (Cementra 

d.o.o., 2013.): 

- vanjska horizontalna popločenja pješačkih površina za jako prometne površine              

(do 10 000 ljudi na dan) 

- za unutarnje vertikalne površine 

- za unutrašnja horizontalna popločenja pješačkih površina za jako prometne 

površine (do 10 000 ljudi na dan) 

- za vanjske vertikalne površine na vezivnom sredstvu visoke nosivosti 

- za zidanje kamenom i masivne kamene elemente 

- za izradu bunja, ciklopa, lomljenog i piljenog kamena i za slične namjene 
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 VEKTORIZACIJA TOPOGRAFSKE KARTE ŠIREG PODRUČJA 

 

U posljednje vrijeme je korištenje računala za modeliranje i prikazivanje 

geometrijskih ploha i oblika u stalnom porastu. Korištenje računala i posebnih računalnih 

programa olakšalo je predočavanje izgleda terena koji se prikazuju kao dvodimenzionalni i 

trodimenzionalni modeli za potrebe rudarstva.  

Trodimenzionalni modeli omogućavaju da se primjenom računalnih programa 

generiraju izlazne veličine poput obujma i opsega stijenske mase, duljine eksploatacijskog 

polja, površine etažnih ravnina, nagiba etaža i/ili kosih prostorija, te druge vrijednosti.  

  

4.1. Unošenje rasterske slike u Microstation 

 

Cilj je da glavne i pomoćne slojnice vektoriziramo u vektorsku kartu (situacijska 

karta), koja će nam služiti za daljnje projektiranje ležišta „Razvala“. Postupak vektorizacije 

topografske karte područja je preko sljedećih koraka: 

U Microstation-u se biraju naredbe: 

File → Raster manager → Attach 

 time se priveže topografska karta područja Knin (Slika 4-1). 

 

 

 
Slika 4-1 Unošenje topografske karte u Microstation 
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Nakon pridruživanja rastera, prikazuje se uže područje ležišta „Razvala“ koje će se 

vektorizirati (slika 4-2.). 

 

 
Slika 4-2 Topografska karta s ležištem „Razvala“, priprema za vektorizaciju, M 1 : 25 000 

 

4.2. Izrada situacijske karte 

 

Vektorizacija karte se radi jednostavnim povlačenjem crta preko slojnica situacijske 

karte.  Za izvlačenje slojnica terena potrebno je iskoristiti  naredbu ,,Place point or Stream 

Curve“ (Postaviti točku ili Strujnu krivulju),  a za izradu vrhova  koji nam pomažu pri 

procesu triangulacije ,,Place Circle“ (Postavi krug).  

 Povlačenje crta je jednostavan postupak. Naredbom ,,Place Point or Stream Curve“ 

lijevim klikom miša odredimo početak slojnice te svakim idućim klikom prilagođavamo crtu 

samim slojnicama. Vektoriziraju se i brojevi slojnica, postojeće prometnice te ostale visine 

sa topografske karte koje će nam kasnije koristiti za dobivanje trodimenzionalnog prikaza te 

za triangulaciju situacijske karte (slika 4-4). 
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Slika 4-3 Situacijska karta dobivena vektorizacijom u mjerilu M 1 : 15 000 

 

4.3. Pozicioniranje topografskih elemenata u prostoru 

 

Izrada 3D modela ležišta zasniva se na dodavanju treće dimenzije slojnicama terena 

tj. iz 2D prikaza podizanje slojnica na njihovu visinu kreiramo treću Z os u prostoru. Taj 

postupak je moguće napraviti nizom naredbi unutar programa, te nakon toga površinu koju 

dobijemo provesti kroz postupak triangulacije. Triangulacija nakon toga omogućava 

primjenu različitih prikaza ležišta ovisno načinu na koji ga se želi prikazati. 
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Kako bi se započeo ovaj postupak potrebno je prvo datoteku koja je u 2D obliku 

pretvoriti u 3D oblik. To se radi  odabirom opcije: 

File → Export → 3D 

Nakon toga u tu situaciju 3D potrebno je zalijepiti projektno stanje na sljedeći način: 

References → Tools → Attach 

 

Elemente  situacijske karte (glavne i pomoćne slojnice, cesta) u trodimenzionalni 

prikaz moguće je podići na dva načina. Prva opcija se izvodi  pomoću Microstation-ove 

aplikacije Mod-z pomoću koje se svaka slojnica iz tlocrta podiže na svoju stvarnu visinu 

kakva je i u prirodi.  Zatim se učita snimljena datoteka te se odabire opcija:  

Utilities → MDL aplications → Browse 

i pronađe se aplikacija mod-z u datoteci u kojoj je pohranjena. Druga opcija je korištenjem 

pomoću naredbe „Set Elevation“, koja se nalazi pod „Power Inroads“ naredbama u skupini 

place feature (slika 4-4). Naredba „Set Elevation“ funkcionira tako da se odabere slojnica 

koja se želi dignuti i taj se postupak ponavlja za sve slojnice. U izradi ovoga projekta 

korištena je aplikacija  „Set Elevation“.  

 

 

Slika 4-4 Odabir naredbe „Set Elevation“ 
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Podizanjem svih slojnica na njihovu visinu dobivamo njihov prikaz u 

trodimenzionalnom okruženju. Trodimenzionalno okruženje omogućava pogled na slojnice 

terena iz svih kutova što daje puno jasniju sliku o terenu. Primjer toga je i na  slici 4-5 i 4-6 

is drugog kuta. Nakon podizanja slojnica poželjno je koristiti opciju „Fence“, pomoću 

naredbe „Place Fence“. Tom naredbom označava se područje koje želimo obrezati na samo 

onaj dio koji je potreban za prikaz istražnog ležišta. Ovim postupkom također se skraćuje 

vrijeme potrebno računalu za obavljanje triangulacije te prikaz prostornog modela. 

 
Slika 4-5„Top View“ pogled na slojnice u 3D prikazu nakon podizanja na njihove visine 

 
Slika 4-6 Slojnice istražnog područja prikazane u 3D modelu 
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4.4. Triangulacija 3D modela postojećeg stanja terena 

 

 Triangulacija modela istražnog prostora predstavlja niz trokuta koji spaja 

karakteristične točke svih crta na odabranom području. Pomoću serije takvih trokuta moguć 

je pregledniji i točniji 3D prikaz nekog modela.  

 

Triangulacija se također radi u aplikaciji InRoads na slijedeći način: 

- Surface → View surface → Contours; Ovom metodom mogu se progustiti 

slojnice metodom interpolacije u cilju što preglednijeg modela. Odabire se 

interval interpolacije te podešavaju svojstva glavnih i pomoćnih slojnica. 

- File → New; Odabere se  ime koje želimo dati površini koju trianguliramo i 

odabiremo naredbu „Apply“. 

- File → Import → Surface: U potpolje „Point Type“ odabiremo opciju 

„Random“, ovime se označuju svi elementi koji će biti triangulirani. 

- Surface → Triangulate surface; Odabere se  površina koja će biti 

triangulirana.  

- Surface → View Surface → Triangles; Odaberemo površinu koju želimo 

vidjeti i podesimo boju modela. 

- Surface → View surface → Perimeter; Odaberemo rub modela oko kojeg 

želimo postaviti perimetar (razvučemo ga prema dolje). 

- Zbog boljeg pregleda modela u opciji „View Display Mode“ odabire se  način 

pogleda „Smooth-modeling“. 

 

Kada se sve ove naredbe podese i postave sve opcije za izgled  modela, dobije se  3D 

model  terena kao što je prikazano na slici 4-7. 
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Slika 4-7 Triangulirani 3D model šireg područja istražnog prostora „Razvala“ 
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 MODELIRANJE ISTRAŽNIH RADOVA, GRANICA REZERVI I ZAVRŠNE 

KONTURE POVRŠINSKOG KOPA 

 

Na temelju obavljenih istražnih radova (zasjeci) i istražnog bušenja dobit će se 

potvrda o prisutnosti rezervi arhitektonsko-građevnog kamena na istražnom prostoru 

„Razvala“. Slijedeći zadatak će biti kategorizacija i klasifikacija rezervi.  

 

5.1.  Kategorizacija rezervi arhitektonsko-građevnog kamena 

5.1.1. Propisana kategorizacija rezervi 

 

Prema vrsti stijena, veličini i oštećenosti stijenske mase uslijed tektonskih pokreta, 

hidrotermalnih procesa, obliku pojavljivanja i drugih utjecaja, ležišta arhitektonsko-

građevinskog kamena (na prostoru uprave FBiH) razvrstavaju se prema Pravilniku o 

klasifikaciji i kategorizaciji rezervi čvrstih mineralnih sirovina i vođenju evidencije o njima 

(Službene novine FBiH, br. 36/12.) u šest grupa:  

1) sedimentne stijene koje se javljaju u obliku slojeva ili leća; velikih su dimenzija i 

sadrže preko 600 000 m3 rezervi stijenske mase; zahvaćenost tektonskim 

pokretima je neznatna i bitno ne utječe na iskorištenje stijenske mase;  

2) sedimentne stijene koje se javljaju u obliku slojeva ili leća; malih su dimenzija i 

sadrže do 500 000 m3 rezervi stijenske mase; tektonskim pokretima su neznatno 

zahvaćena, što ne utječe na iskorištenje stijenske mase;  

3) metamorfne stijene; javljaju se u obliku leća, velikih su dimenzija i sadrže preko 

500 000 m3 rezervi stijenske mase, a mogu imati i manje dimenzije, sa rezervama 

ispod 500 000 m3 stijenske mase; zahvaćenost tektonskim pokretima je slabija i 

stijenska masa sadrži preko 15% sirovih blokova;  

4) ležišta (rudna tijela) ukrasnog kamena koja su oblika i veličine kao ležišta (rudna 

tijela) treće grupe; tektonskim pokretima stijenska masa je jače zahvaćena i sadrži 

do 15% sirovih blokova;  

5) ležišta (rudna tijela) ukrasnog kamena koja čine magmatske stijene; javljaju se u 

obliku lećastih masa, odnosno gnijezda i drugim nepravilnim oblicima; velikih su 

dimenzija i sadrže preko 400 000 m3 rezervi stijenske mase, a mogu biti i manja, 

sa rezervama ispod 400 000 m3 stijenske mase; tektonskim pokretima, 
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hidrotermalnim procesima i drugim utjecajima stijenska masa je slabije zahvaćena 

i sadrži više od 10% sirovih blokova;  

6) ležišta (rudna tijela) ukrasnog kamena koja su oblika i veličine kao ležišta (rudna 

tijela) pete grupe; tektonskim pokretima, kao i djelovanjem hidrotermalnih 

procesa i drugih štetnih utjecaja, stijenska masa je znatno zahvaćena i sadrži manje 

od 10% sirovih blokova. 

 

Prema navedenoj podjeli istražni prostor „Razvala“ pripada u prvu grupu ležišta. 

 

Maksimalne udaljenosti između istražnih radova propisane „Pravilnikom o 

prikupljanju podataka, načinu evidentiranja i utvrđivanja rezervi mineralnih sirovina te o 

izradi bilance tih rezervi“ (Službene novine FBiH, br. 36/12.) prikazane su u tablici 5-1.  

 

Tablica 5-1 Maksimalne udaljenosti istražnih radova (Službene novine FBiH, br. 36/12.) 

Grupa ležišta 
(rudnih tijela) 

Maksimalna udaljenost između istražnih radova, u m  

A kategorija  B kategorija  C1 kategorija  

I 100  200  300  

II 80  160  240  

III 70 150 220 

IV 60  120  180  

V 60  120  190  

VI 50 100 150 

 

5.1.2. Raspored istražnih radova i određivanje granica rezervi 

 

Metode istraživanja : 

 

Istražni radovi će obuhvatiti: 

1. Istražno bušenje: 6 bušotina na jezgru. 

2. Izradu zasjeka: 5 zasjeka, u prosječnoj dužini oko 29 m i visini 9 m. 

3.  Uzimanje uzoraka stijene za kompletnu analizu fizikalno-mehaničkih značajki 

arhitektonsko- građevnog kamena.  

4. Probnu eksploataciju (svi zasjeci) u opsegu od oko 500 m3 ukupnog stijenskog 

materijala, temeljem čega će se snimiti pukotine i udaljenost između njih te 

izraditi strukturni plan (M 1:100) i utvrditi možebitnost postojanja zdravih 

blokova. 
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Raspored istražnih radova: 

Na slici 5-1. prikazan je raspored istražnih radova u odnosu na cijeli istražni prostor 

a na slici 5-2. prikazan je i prijedlog granica kategorija rezervi. 

Osnovna razina na kojoj započinju istraživanja je na visini od 820 m, a najviša točka 

istraživanja je 1310 m što čini visinsku razliku od 490 m kao što je vidljivo na slici 5-1. 

 

 

Slika 5-1 Pozicije istražnih radova s istražnim bušotinama, M 1 : 15 000 

5.1.3. Određivanje granica rezervi 

 

Rezerve arhitektonsko-građevnog kamena definirane su stupnjem istraženosti ležišta. 

Uzorci dobiveni bušotinama i raskopima nose se u laboratoriji te se na njima izvode 

ispitivanja koja nam omogućavaju da definiramo o kojim se  kategorijama rezervi radi u 

ležištu. Najdetaljnija istraživanja naravno potrebna su za mineralne sirovine A kategorije. 

Nakon njihova utvrđivanja za tu kategoriju nije dozvoljena ekstrapolacija. Kod rezervi B i 

C1 kategorije ekstrapolacija je dozvoljena do 20% odnosno 30% maksimalne udaljenosti 

istražnih radova, ako se radi o jednostavnim uvjetima u ležištu (Službene novine FBiH, br. 

36/12.). Prilikom određivanja lokacija istražnih radova to su pravila kojima se treba voditi 

uz naravno prilagodbu postojećoj konfiguraciji terena. Tako je u slučaju „Razvala“  približna 
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slika  kategorija rezervi arhitektonsko-građevnog kamena na istražnom prostoru prikazana 

na slici 5-2. Kategorije rezervi C1 nisu uzete u obzir zbog veličine prostora već zahvaćenim 

u A i B kategoriju. Ekstrapolacija nije uzeta u obzir jer je još uvijek nedovoljno podataka za 

ocjenu složenosti ležišta arhitektnosko-građevnog kamena. Završni raspored istražnih 

radova i položaj granica leižišta A i B kategorje je prikazano na slici 5-3. 

 
Slika 5-2 Položaj granica ležišta u ograničenom prostoru, M 1 : 25 000 
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Slika 5-3 Raspored istražnih radova, M 1 : 15 000 

5.1.4. Izrada 3D modela granica rezervi 

 

Prikaz granica rezervi napravljen je i u obliku 3D modela. Postupak započinje 

učitavanjem postojeće datoteke 2D oblika u kojoj smo postavili rezerve. Zatim je potrebno 

sve rezerve podignuti na visinu osnovnog platoa koji ovdje iznosi 1000 m. To se učini  uz 

pomoć naredbe:  

Surface → Design Surface → Set Elevation 

Nakon podizanja kategorija rezervi na visinu osnovnog platoa dobiju se  donje 

granice, a za gornje granice koje slijede visinu terena potrebno je koristiti naredbu: 

Surface → Design Surface → Drape Surface 

Podizanjem svih granica na njihove visine dobijemo prikaz rezervi kao na slici 5-4.  
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Slika 5-4 3D prikaz kategorija rezervi 

 

5.2. Modeliranje završne konture površinskog kopa 

5.2.1. Utvrđivanje projektnih parametara površinskog kopa 

 

Nakon određivanja kategorija rezervi potrebno je odrediti i projektne parametre, 

odnosno napraviti geometrijsku analizu kontura rudarskih radova koja će u konačnici 

definirati izgled kopa.  

Na ležištu „Razvala“ predviđena je ekspolatacija arhitektonsko-građevnog kamena 

koja bi se obavljala površinskim kopom.  

Površinski kopovi općenito su definirani slijedećim parametrima: 

- visina etaža,  

- broj etaža,  

- širina etaža 

- nagibi etažne, radne i završne kosine 

 

Definicijom navedenih parametara formira se fronta rudarskih radova te radna zona.  
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Za ležišta arhitektonsko-građevnog kamena nagib etažnih kosina je približno 90o, a 

visina etaža je najpovoljnija od 6 do 10 m, što je ovisno o uvjetima u ležištu i tehnološkim 

zahtjevima eksploatacije (operativne mogućnosti strojeva i opreme) i tržišta (dimenzije 

blokova).  

Visine etaža veće od 10 m su zahtjevnije kako zbog stabilnosti kosina, tako i iz 

razloga što je s porastom visine etaže iznad 10 m eksploatacija tehnološki otežana.  

Na ležištima arhitektonsko-građevnog kamena eksploatacija se izvodi tako što se 

sirovina pili u kamene blokove koji se zatim vade, te transportiraju na daljnju preradu. Kako 

bi se osigurao neometan rad strojevima i ljudima na eksploatacijskom polju potrebno je 

odrediti dovoljno veliku širinu etaže.   

 Geometrijski (projektni) parametri na površinskom kopu „Razvala“ određeni su, s 

obzirom na uvjete u ležištu i iskustvene podatke s okolnih površinskih kopova, uz pomoć 

izraza koji se primjenjuju za izračun parametara. Visinska razlika na ležištu doseže 105 m, 

što se dobije razlikom najviše točke 1105 m i kote osnovnog platoa koji se nalazi na 1000 

m. Visina etaža iznosi 6 m, a širina je 3 m. Kut nagiba etažne kosine je približno 90°, a kut 

nagiba završne kosine je  55°. 

Broj etaža definiran je omjerom visinske razlike ležišta i visinom jedne etaže. Kako 

su obje vrijednosti poznate taj broj je lako odrediti slijedećim izrazom 5-1 (Blažević, 2007): 

 

n = H/h = 105/6 = 17,5 (usvojeno 17 etaža)   (5-1) 

pri čemu je: 

n - broj etaža, 

H - visinska razlika između terena i platoa osnovne etaže  

      do kote do koje će se vršiti eksploatacija, 105 m 

h - visina etaža, 6 m 

 

5.2.2. Izrada (geometrizacija) 2D prikaza završnih kontura površinskog kopa 

 

 Izrada završnih kontura površinskog kopa na situacijskoj karti je postupak 

geometrijskog oblikovanja etaža u okviru granica utvrđenih rezervi.  

Postupak geometrizacije etaža može se, u pravilu, izvoditi na dva načina: odozgo 

prema dolje ili odozdo prema gore.  U ovom radu etaže su iscrtane od najniže prema najvišoj.  
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No, prije iscrtavanja etaža potrebno je nacrtati projekciju završne kosine (Xz) na karti 

kategorizacije rezervi. Projekcija završne kosine se crta uvijek od krajnjih granica (najniže 

kategorije) utvrđenih rezervi prema osnovnoj ravnini (razini) utvrđenih rezervi. 

Kod crtanja etaža donji rub završne kosine (crtkana linija) će biti ujedno i donji rub 

prve etažne kosine. 

U računalnom programu Microstation, pomoću naredbe „Copy/Move Parallel“ 

prekopirati će se donji rub projekcije završne kosine prema krajnjim granicama rezervi B 

kategorije), za širinu etaže od 6 m. To će predstavljati prvu višu etažu iznad osnovne etaže. 

Praktično, kopirana projekcija predstavlja ujedno i rubove ravnine etaže a ujedno i projekciju 

etažne kosine. Budući je etažna „kosina“, ili drugačije rečeno ploha, vertikalna ili 

subvertikalna projekcija se poklapa s rubovima etaža, što se na karti ili slici ogleda kao jedna 

crta. 

Nastavno na započeti postupak geometrizacije, konturu etaže  treba iskopirati 

usporedno prema granicama ležišta za vrijednost radne etaže (berme), koja u ovom slučaju 

iznosi 4 metara. Postupak se ponavlja 16 puta jer imamo 16 bermi. Etaže se iscrtavaju do 

slojnica koje pripadaju određenoj etaži. Ovim postupkom dobijemo etaže u tlocrtu sa 

njihovim pripadajućim visinama (slika 5-5). 

 

 
Slika 5-5 2D prikaz geometrizacije završnih kontura površinskog kopa „Razvala“ M 1 : 15 000 
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5.2.3. Izrada 3D modela površinskog kopa 

 

Prvi korak, prije izrade 3D modela,  je prebacivanje datoteke (konverzija), u kojoj se 

nalaze geometrijski elementi i likovi, iz 2D polja (ravnina) u 3D polje (prostor).  

Postoji mogućnost izravnog crtanja geometrijskih elemenata i likova u datoteci koja 

je već uređena u 3D polju, no, to je puno složeniji postupak i neće se koristiti u ovom radu. 

Prebacivanje datoteke, s kreiranim sadržajima, koja podržava 2D polje, odnosno 

kreiranje nove datoteke koja podržava 3D polje izvodi se pomoću naredbe  

File → Export → 3D 

 

Time je pored prebacivanja datoteke iz 2D u 3D okruženje izvršeno i njezino 

spremanje, odnosno kreiranje nove, neovisne datoteke. Stoga se za nastavak rada u 3D polju 

treba otvoriti nova kreirana datoteka i nastaviti rad. 

Postupak kreiranja kontura kopa kod etaža s vertikalnom kosinom (a-g kamen) je 

malo drugačiji od kreiranja etaža s blažom kosinom od 90°. Razlog tomu je taj što projekcija 

gornjeg i donjeg ruba etaže pada u istu crtu. Stoga se crta koja graniči dvije etaže mora 

kopirati i podići za visinu etaže, a to je u ovom kopu za 6 m.  

No, prije kopiranja i podizanja gornje konture etaže neophodno je ukazati na tehničku 

nemogućnost računalnog programa Bentley InRoads, u kojem se izvodi obrada i 

triangulacija 3D modela, da napravi inicijalnu triangulaciju 3D modela i ploha koje su 

nagnute pod 90° ili više. U tom slučaju događa se anomalija odnosno kriva obrada podataka 

tako da se dobiju nepostojeće plohe. Tehničko rješenje ove anomalije sastoji se u tome da se 

gornji rub etaže usporedno pomakne za vrlo mali pomak koji ne utječe ni na proračune a niti 

na geometriju kopa. Prema tome, etažni kut treba smanjiti za npr. 0,01°, što predstavlja 

neznatnu pogrešku od oko 0,01%.  

U praktičnom smislu to znači da svaku graničnu crtu između etaža i krajnju crtu 

najviše etaže treba kopirati i usporedno pomaknuti, pomoću naredbe „Copy/Move Parallel“, 

za približno 1 mm. Praznine između rubova crta treba spojiti sa naredbom 'Extend 2 

Elements to Intersection', a subvertikalne kosine između etaža treba spojiti na presječnicama 

pravaca. Pri tome je važno napomenuti da se ove radnje izvode na visini 0 m. 

 Nakon opisane pripreme kontura etaža na razini 0, slijedi podizanje napravljenih 

etaža na njihovu pravu visinu. To se radi isto kao i sa slojnicama sa naredbom Set Elevation. 

Kada su podignute sve etaže na njihovu visinu potrebno je podići i gornje krajeve etaža koji 
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prate teren i koji su prethodno napravljeni pomoću naredbe Generate sloped surface. To će 

se učiniti naredbom „Drape Surface“. Ova naredba se koristi, dakle, kako bi crte gornjih 

rubova etaža pratile postojeći teren i u 3D okruženju. Pri tome treba aktivirati prethodno 

formiranu površinu situacijske karte, što se izvodi u potprogramu InRoads. Namjeste se sve 

postavke te se pritisne Apply. Klikne se na crtu koju se želi podići do visine terena. Dobivene 

visine u 3D prostoru prikazane su na slici 5-6. 

 
Slika 5-6 3D model konture površinskog kopa 

 

5.2.4. Triangulacija prostornog modela površinskog kopa 

 

Kao što je prethodno u tekstu navedeno, da bi se triangulacija uspješno obavila 

potrebno je izvršiti pomak gornjeg ruba etaže. Ta nesavršenost računalnog programa ne 

utječe znatno na krajnji izgled prikaza etaža pa je zbog toga zanemariva. Računalni program 

ne može interpretirati plohe s kutem od 90o  jer je njihov tangens kuta beskonačna vrijednost. 

Kada pomaknemo gornji rub svih etaža dobijemo nagib etažnih ravnina pod kutem manjim 

od 90o (npr. 89,99°) i tada se triangulacija može obaviti pravilno i točno.  

Kada se podesi nagibe svih etažnih ravnina započinje proces triangulacije etaža. 

Triangulacija etaža se kao i triangulacija terena radi pomoću aplikacije InRoads. Prvo se 

pomoću naredbe:  

File → New 
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otvara nova datoteka dtm. formata u kojoj će se spremiti svi podaci triangulirane površine. 

Zatim se naredbom: 

File → Import → Surface 

odabire naziv i površina koju se želi triangulirati (etaže i osnovni plato). Nakon toga odabire 

se: 

Surface → Triangulate surface 

gdje se odabire naziv površine koju  se želi triangulirati. Potom idemo na: 

Surface → View Surface → Triangles 

gdje se podešava boju i level triangulirane površine kojom će se ona prikazati. Na kraju se u 

„View Display Mode“ prebacuje „Wireframe“ (slika 5-7) na „Smooth-modeling“ način 

(slika 5-8) prikazivanja jer on omogućuje bolji i detaljniji prikaz triangulirane površine.  

 
Slika 5-7 Konture površinskog kopa nakon postupka triangulacije: Wireframe (žični) prikaz 

 

 
Slika 5-8 Konture površinskog kopa nakon postupka triangulacije: Smooth modeling prikaz 
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Slika 5-9 Završno stanje ležišta „Razvala“ 

 

 

Odgovarajućim odabirom u izborniku Surface:  

Surface → Design Surface  

 

dolazi se do naredbe „Drape Surface“ kojom se površina iz tlocrta može prenijeti na 

trodimenzionalni prikaz terena (Soldo i Šetka, 2016).  Triangulirane završne etaže možemo 

također prikazati u širem istražnom području (slika 5-9). 
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 PRORAČUN REZERVI I TEHNIČKO-EKONOMSKA OCJENA LEŽIŠTA 

6.1. Klasifikacija rezervi arhitektonsko-građevnog kamena 

 

S obzirom na klasu rezerve mineralne sirovine  mogu biti bilančne ili izvanbilančne 

Bilančne rezerve definiramo kao one koje su u određenom trenutku postojećom tehnikom i 

tehnologijom eksploatacije i prerade mogu rentabilno koristiti, dok su izvanbilančne rezerve 

one rezerve koje se u određenom trenutku postojećom tehnikom i tehnologijom eksploatacije 

i prerade ne mogu rentabilno koristiti (najčešće rezerve u završnim kosinama kopa i 

zaštitnim stupovima). Klasifikacija rezervi utvrđuje se tehničko-ekonomskom ocjenom, pri 

čemu su analizom obuhvaćeni: geološki, genetski, tehničko-eksploatacijski, tehnološki, 

regionalni, tržišni i društveno-gospodarski parametri. 

Kontura završnog stanja predstavlja zapravo granicu bilančnih i izvanbilančnih 

rezervi te se pretpostavlja da su sve količine iznad razine završnog stanja osnova za proračun 

bilančnih i eksploatacijskih rezervi (slika 6-1). Isto tako, sve količine ispod završne konture 

(kosine) predstavljaju osnovu za proračun izvanbilančnih rezervi. 

 

 
Slika 6-1 Raspored i konture presjeka 
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6.2. Proračun rezervi arhitektonsko-građevnog kamena  

6.2.1. Proračun obujma metodom računalnog modeliranja (mrm) 

 

Metoda računalnog modeliranja je jedna od najsuvremenijih metoda koja se već 

uvelike primjenjuje u svim razvijenijim rudarskim zemljama. Da bismo mogli upotrijebiti 

ovu metodu prethodno smo izradili triangulacijski ili mrežni model ležišta arhitektonsko-

građevnog kamena. Metoda računalnog modeliranja u teoriji funkcionira na način da 

računalo računa integral između trianguliranih trokuta (najmanjih dijelova plohe). Za svaki 

trokut računa se obujam do njemu nasuprotnog trokuta tj. računa se obujam koji zatvaraju 

nasuprotni trokuti. Zbrajanjem ili oduzimanjem vrijednosti pojedinih vrijednosti obujmova 

dobije se ukupan obujam između pojedinih ploha, u našem slučaju početnog stanja i 

projektiranog stanja (Galić i Farkaš, 2011). 

Računalna metoda proračuna rezervi radi se u aplikaciji InRoads tako da se odabere 

naredba:  

Evaluation → Volumes → Triangle Volume. 

Nakon toga, otvara se prozor u kojem odabiremo dvije već snimljene površine 

situacija-triangulacija.dtm i plato-triangulacija.dtm između kojih će računalo izračunati 

obujam i odabire se opcija add. Odabire se „Cut“ i „Fill Factor“ koji nam iznosi 1,0 za oba 

faktora te se odabire opcija „Apply“ (Vrdoljak, 2013). 

6.2.2. Proračun bilančnih rezervi  (metodom vertikalnih paralelnih presjeka) 

 

 Ova metoda može se raditi na dva načina: manualno (ručno) ili računalno. Za ovo 

ležište primijenjena je manualna metoda. Ova metoda se temelji na postavljanju niza 

presjeka duž ležišta. Važno je postaviti presjeke kroz karakt-eristične točke u kojima dolazi 

do  promjene terena, sastava mineralne sirovine te na granicama rezervi različitih kategorija.  

Metoda paralelnih vertikalnih presjeka teoretski gledano zasniva se na računanju 

površina svakog presjeka pojedinačno (slike 6-2). Zatim se računa aritmetička sredina 

površina presjeka između susjednih presjeka po formuli 6-1: 

1P = 
2

n n
sr

P P ++
      (6-1) 
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Pn – površina n-tog vertikalnog presjeka, m² 

Pn+1 – površina n+1 vertikalnog presjeka, m² 

n – broj presjeka 

 

Kada se susjedne površine razlikuju za više od 40% onda se srednja površina računa prema  

izrazu 6-2: 

1 1*
P = 

3

n n n n

sr

P P P P+ ++ +
     (6-2) 

Psr – srednja površina, m² 

P1 – površina prvog presjeka, m² 

P2 – površina drugog presjeka, m² 

 

Za izračunavanje obujma, aritmetička sredina površine dvaju presjeka se množi sa 

udaljenosti između dva postavljena presjeka, prema izrazu 6-3:  

... 1 ... 1*n n sr n nO P l+ +=      (6-3) 

O – obujam, m³ 

l – udaljenost između dva presjeka, m 

ln – udaljenost između n-tog i n+1 presjeka 

 

Taj postupak se ponavlja za sve susjedne presjeke i u konačnosti se svi dobiveni 

obujmi zbrajaju prema izrazu 6-4: (Galić i Farkaš, 2011): 

1

r

i
i

O O
=

=å        (6-4) 

i – broj bloka 

r – ukupni broj blokova (=broj presjeka-1) 
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Slika 6-2 Primjer iscrtanog presjeka sa označenim granicama i količinama rezervi 

 

Konkretno, u našem slučaju, obujam se računa tako da se na svakom presjeku računa 

srednja površina bilančnih (A, B) i izvanbilančnih rezervi (površine iza etaža) između dva 

susjedna presjeka, te se ona množi sa udaljenosti između ta dva presjeka.  

Tablica 6-1 Proračun obujma za bilančne rezerve po presjecima 

 
  

Da bi se dobile rezerve prvo se pomoću formula izračuna obujam koji se zatim mora 

množiti sa popravnim koeficijentom, te se dobiju bilančne i izvanbilančne rezerve. Bilančne 

rezerve (Tablica 6-1) se potom umanjuju za iznos eksploatacijskih gubitaka, te se dobiju 

eksploatacijske rezerve. 

Popravni koeficijent je koeficijent koji se uvodi u proračun rezervi ako postoji 

sumnja da su pri obračunu rezervi proračunati parametri, metode ispitivanja, kemijske i 

druge analize nedovoljno točni. Popravni se koeficijenti mogu odnositi na sadržaj korisnih i 

štetnih komponenti, prostornu masu, vlažnost, površinu, obujam rudnog tijela i dr. 
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Popravni koeficijent i udio eksploatacijskih gubitaka se dobivaju na različite načine, 

teorijski i empirijski. Obzirom da se na ležištu Razvala tek očekuju egzaktni podaci, za ovu 

priliku i proračun rezervi, uzete su prosječne vrijednosti iz okruženja, odnosno s površinskih 

kopova iz Hercegovine i Dalmacije. 

 Usvaja se popravni koeficijent, u iznosu od 0,20 i eksploatacijski gubitak od 10%. 

 

Uvrštavanjem usvojenih vrijednosti mogu se izraziti simulirani iznosi rezervi, kao 

što je prikazano u tablicama 6-2 i 6-4. 

 

Tablica 6-2 Proračun bilančnih i eksploatacijskih rezervi mineralne sirovine 

 

 

6.2.3. Proračun izvanbilančnih rezervi  

 

Izvanbilančne rezerve su, kao što smo to već ranije rekli, sve one rezerve koje se u 

datom trenutku postojećom tehnikom i tehnologijom ne mogu rentabilno koristiti, odnosno 

one koje se nalaze u završnim kosinama te zaštitnim stupovima. Prema tome u našem ležištu 

potrebno je proračunati izvanbilančne rezerve iza etaža jer nam one predstavljaju završnu 

kosinu. To se radi na isti način kao i za bilančne rezerve. Kao i bilančne rezerve i 

izvanbilančne se nakon proračuna korigiraju sa popravnim koeficijentom i umanjuju se za 

eksploatacijske gubitke, što je prikazano u tablici 6-4. 
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Tablica 6-1 Proračun obujma za izvanbilančne  rezerve 

 

 

Tablica 6-2 Količine izvanbilančnih rezervi 
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 METODA DOBIVANJA BLOKOVA 

 

Prvom istražnom eksploatacijom, dobiven je uvid u postojeće stanje stjenskih masa. 

Uočeno je da se stijena odvaja po diskontinuitetima i da dijelovi slojeva prodiru na površinu. 

Stoga je predviđeno da optimalna metoda razvoja rudarskih radova mora biti po pružanju i 

nagibu slojeva i da se slojevi moraju odvajati po diskontinuitetima. Slojevi će se piliti strojno 

tako da rezovi budu okomiti na slojevitost po pružanju i vertikalni po nagibu. Eksploatirati 

će se u paketima odozgo prema dolje. Na taj način će se dobiti približno pravilna 

geometrijska tijela koja su komercijalno najvrijednija.  

 

Po uzoru na druga slična ležišta a-gk (npr. „Poljane“ kod Jajca) predlažu se odabrane metode 

(Galić i dr., 2016): 

- Piljenjem dijamantnom žičnom pilom kako po smjeru nagiba sloja (vertikalni rez) 

tako i po pružanju sloja (okomiti rez na plohu slojevitosti); 

- Piljenjem dijamantnom žičnom pilom po pružanju sloja (okomiti rez na plohu 

slojevitosti) te bušenjem bušotina i odvaljivanjem hidrauličnim klinovima po smjeru 

nagiba sloja (vertikalni rez); 

- Piljenjem lančanom sjekačicom po smjeru nagiba sloja (vertikalni rez) i lančanom 

sjekačicom po pružanju sloja (okomiti rez na plohu slojevitosti); 

- Piljenjem lančanom sjekačicom po smjeru nagiba sloja (vertikalni rez) i 

dijamantnom žičnom pilom po pružanju sloja (okomiti rez na plohu slojevitosti); 

- Piljenjem lančanom sjekačicompo pružanju sloja (okomiti rez na plohu slojevitosti) 

i dijamantnom žičnom pilom po smjeru nagiba sloja (vertikalni rez). 

Od navedenih metoda u daljnem tekstu detaljnije je opisana metoda piljenjem lančanom 

sjekačicom. 

7.1.  Dobivanje osnovnih blokova sjekačicama 

 

Razvojem tehnologije, sjekačice s mačem se danas konstruiraju tako da im duljina 

mača seže i do 8 m što otvara mogućnosti dobivanja reza do približno iste efektivne 

vrijednosti. Takve sjekačice u fazi radova traže velike otvorene površine, stoga je u ranoj 

fazi otvaranja potrebno provesti takva tehnološka rješenja da se omogući primjena sjekačice. 



 

36 

 

S druge strane, jednostavniji i brži rad omogućava dobivanje blokova pod nagnutnim 

plohama i time najveću komercijalnu iskoristivost bloka.  

 

Slika 7-1 Shema dobivanja blokova s  Fantini S8 sjekačicomi radne operacije (Galić i dr., 2016) 

 

Na slici 7-1 predložena je shema dobivanja blokova sa lančanim sjekačicama (tipa 

S8 i S4 sukladno shemi koja je predlagana na ležištu a-gk „Poljane“ kod Jajca (Galić i dr., 

2016). 

Prema toj shemi, osnovni blokovi projektiranih dimenzija (6 m × 3 m × 4 m), dobivat 

će se kombinacijom lančanih sjekačica s duljinom mača od 4 m i 6 m. Pri tome treba istaknuti 

da se sjekačica s duljinom mača od 6 m (S8) koristi za izradu vertikalnog reza do 6 m debljine 

paketa, a sjekačica duljine mača od 4 m (S4) za horizontalni rez dubine 4m i za rezanje 

osnovnih blokova (slike 7-2 i 7-3). To je dakako, najnapredniji način dobivanja. 

Prema tome, postupak dobivanja osnovnih blokova je slijedeći (slika 7-1): 

- skinuti otkrivku, bagerom, u smjeru nagiba sloja (1) 

- ispiliti vertikalne rezove sjekačicom S8 (2) po nagibu sloja, na međusobnoj 

udaljenosti od 4 m, po dubini od 6 m 

- ispiliti kose rezove sjekačicom S4 (3), po pružanju sloja (okomito na slojnu plohu), 

na međusobnoj udaljenosti od 3 m, po dubini od 4 m 

 

U razvijenoj fazi radova na površinskom kopu moći će se primijeniti metode 

dobivanja visokih kapaciteta, koje zahtijevaju velike otvorene površine.  
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Slika 7-2 Značajke sjekačice Fantini S8 (a) i primjer njezinog rada (b,c i d)  (Galić i dr., 2016) 

 

Blokovi se odvaljuju i prevalju na radnu plohu u suprotnom smjeru od čela. Završni 

blokov se formiraju na radnoj plohi sjekačicom S4 i žičnom pilom ako kapaciteti sjekačice 

ne budu dovoljni. Rezanje se nastavlja s obje sjekačice sve do kraja eksploatacije paketa 

slojeva (Galić i dr., 2016). 

 

Položaj sjekačica će biti takav da se omogući rad na najmanje dva čela. Završni 

blokovi će se dobivati na čelu (slika 7-4) usporedno s dobivanjem osnovnih blokova na 

drugom čelu.  
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Slika 7-3 . Lančana sjekačica Fantini S4: značajke (a) i primjer njezinog rada (b,c, d i e) (Galić i dr., 2016)  
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Slika 7-4 Dobivanje završnog bloka sjekačicom 
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 ZAKLJUČAK 

 

 

S prvim programom i prvim istražnim rezultatima dobiveni su preduvjeti za moguće 

daljnje istraživanje ležišta „Razvala“. Ovim diplomskim radom smo proširili i predložili 

mogući razvitak budućeg površinskog kopa arhitektonsko-građevnog kamena.  

Računalnom metodom i metodom paralelnih vertikalnih presjeka dobili smo uvid u 

količinu mineralne sirovine i isplativosti ulaganja za buduće detaljnije istraživanje. 

Primjerom dobivanja primjenom lančanih sjekačica s duljim mačem dan je prijedlog za 

dobivanje blokova.  

Primjena računalnih programa, uvelike olakšava proces proračuna, izgradnje, 

vizualizacije i drugih radnji pri provedbi određenog inženjerskog zahvata, odnosno smanjuje 

potrebno vrijeme za njegovu realizaciju. Vizualizacijom u 3D modelu dana je šira slika 

zahvata koja omogućuje kvalitetnije shvaćanje prostora u kojemu se radovi odvijaju te 

također dopušta široj javnosti da dobije bolju percepciju o planiranom zahvatu. 
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PRILOG br. 1 Obračunski presjeci
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PRILOG br. 2 Uvjerenje-Smiraj RAZVALA-2013 
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